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Introduc琀椀on 

 

In terms of machine development and applica琀椀on, no machine has advanced as rapidly as 
the computer. Not long ago, computers were massive structures with miles and miles of 
wiring that only performed tasks that are now considered very simple. 

Computers are now an integral part of our daily lives. There is no escaping this wonderful 

machine, whether we are at work, on vaca琀椀on, studying at school or college, or simply going 
to the grocery store. 

It is becoming increasingly important that children learn how to use this machine at the 

earliest possible opportunity. That opportunity comes in the form of computer educa琀椀on at 
school. S琀椀ll, any type of educa琀椀on provided at the early stages of learning must not only be 
comprehensive but also presented in a way that is simple for both the teacher to explain and 

the students to understand. This is where Smart Compu琀椀ng stems from. 

The Smart Compu琀椀ng series comprises five books. These books provide informa琀椀on on the 
awareness of devices found in people's homes and how to use them. 

 

Introduc琀椀on to the teaching guides 

Lesson plans, useful 琀椀ps, and worksheets with interes琀椀ng learning ac琀椀vi琀椀es are all included 
in the teaching guide. A list of goals and learning outcomes appears in each lesson. You can 

create your lesson plans by using the provided sample plans. The lesson plans comprise 

introductory ac琀椀vi琀椀es las琀椀ng 3 to 5 minutes, which explain the concepts being taught. This is 

followed by 30 minutes of explana琀椀on and a 5-minute recap. Sample worksheets have been 

provided where need be for addi琀椀onal support. Answers to exercises within the lessons have 
also been provided. 
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Lesson 1 - Computers: A Journey of Innova琀椀on 

This lesson can be taught in two periods. 

Period 1 

Teaching objec琀椀ves 

• To understand the five genera琀椀ons of computers 

• To understand how they improved over 琀椀me 

Learning outcomes 

By the end of the lesson, the students will be able to classify computers into different 
genera琀椀ons based on the technology used. The students will also be able to briefly describe 
the 4th genera琀椀on of computers. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Have a discussion about desktop computer features with your students before star琀椀ng the 
lesson. You can ask them to list the basic components of a desktop computer or describe 

what they do. Tell them about the various stages that the modern desktop computer went 

through to get to where it is now. 

Main Lesson: 30 minutes 

Read pages 4 and 5 with your students. Discuss the history of computers with them. Tell 

your students that before computers, simple math opera琀椀ons were performed by hand 
using tools like Abacus. If you can get a toy abacus to show in class, that will be helpful. 

Proceed to have a detailed discussion with your students about the five genera琀椀ons of 
computers. You may have a discussion towards the end to clear any doubts that the students 

may have.  

Bring different photos of computers from different genera琀椀ons and ask your students the 
differences between them. Their responses could be: different in sizes, storage space were 

different, the amount of electricity used, more people used to operate the computer, etc. 

You can write their responses on the board. Alterna琀椀vely you can ask them the following 
ques琀椀ons: 

• What differences can you find between the computers shown?  
• Which one would you choose to use and why? 

Ask the students to do exercise C in their notebooks. 
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Period 2 

Teaching objec琀椀ves 

• To understand the integrated circuit and highlight its impact on the computer 

industry 

• To understand how the Internet was formed 

Learning outcomes 

By the end of this lesson, students will be able to explain how integrated circuits helped 
computer to evolve. They will also understand the importance of Internet and how it was 

formed. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Show a picture of integrated circuits to your students. Ask them if they know what it is. 

Allow them to share their thoughts. 

Main lesson: 30 minutes 

Ask the children to read pages 5 and 6 with your assistance. You can show them photos of 

computers that dated in these genera琀椀ons. Let the students know that an IC led to the 

inven琀椀on of the microprocessor which is an integral part of all computers today. 

Recall some details about the opera琀椀ng system. Tell the students that before Microso昀琀 
Windows, the most common opera琀椀ng system was DOS (Disc Opera琀椀ng System).  

Explain how computers are classified based on how they process and present data to users. 
Analogue computers provide accurate data, but users may struggle to read it clearly. On the 

other hand digital computers provide output that can be read easily. You can give the 

example of an analogue clock and a digital clock. 

While discussing about the 4th genera琀椀on computers, write the word CPU on the board. Ask 
the students what it stands for. Show a photograph of CPU to explain that the CPU has a 

microprocessor inside the system unit. 

While discussing about networks in this lesson, you can guide students through the 
computer lab; poin琀椀ng out the cables that connect the various computers. You may need to 

explain that some computers are connected even if the cables are not visible. Explain that a 

network is a group of computers connected through wired or wireless means. 

Demonstrate how all computers in the lab can access resources like printers and scanner by 

using the print command. Demonstrate how a file or a document can be accessed from one 

computer to another through a LAN connec琀椀on. 
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Let the children read the fi昀琀h genera琀椀on on page 6 with your assistance.  

Ask them the following ques琀椀on: What do you understand by the term ar琀椀ficial intelligence? 

Explain that it is a way to teach machines  how to learn from experiences. Give them 

relatable examples, such as Siri or Alexa, that they likely use on a daily basis without realising 

the ar琀椀ficial intelligence systems. You could also give them examples of YouTube and Spo琀椀fy 
pla琀昀orms that uses AI systems to suggest videos and songs based on your past choices. Fun 
filters that turn your face into a scuba diver or other characters use AI, par琀椀cularly computer 
vision and face recogni琀椀on. 

Explain that a computer that thinks like a human is supposed to have ar琀椀ficial intelligence. 
Once the meaning is clear, ask them why there is a need for ar琀椀ficial intelligence in a 
computer. 

Lesson wind up: 5 minutes 

Recap what has been taught in the lesson. You can do the exercises as classwork or 

homework. 
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Sample Worksheet 

 

Match the following: 

1. IC      First Genera琀椀on 

2. IBM 701    Third Genera琀椀on 

3. Transistors    Ar琀椀ficial Intelligence 

4. Fi昀琀h Genera琀椀on   Second Genera琀椀on 

 

Answer the following: 

A. Which genera琀椀on of computer are we currently using? 

B. Differen琀椀ate between third and fourth genera琀椀on of computers. 

 

Draw a picture of transistor in your answer sheet. 

 

  



Page 6 

 

Exercise Answers 

A. Fill in the blanks with the correct answers: 

1. 1st genera琀椀on  
2. Transistors 

3. Integrated circuit 

4. Parallel processing hardware and ar琀椀ficial intelligence  
5. Microprocessor 

 

B. Read the informa琀椀on given below and find out the hardware. 

1. Vacuum tubes 

2. Integrated circuit 

3. Microprocessor 

 

C. Write some lines for each genera琀椀on of computer from first genera琀椀on to 4th 
genera琀椀on. 

First genera琀椀on computers consumed more power and generated heat. Input was based 

on punched cards and paper tape. Output was given in the form of printouts. 

Transistors massively reduced the size of the computers and improved the performance 

manifold of second genera琀椀on computers. Their instruc琀椀ons were stored in their 

memory. 

The third genera琀椀on of computers used integrated circuits (IC). On a single integrated 

circuit, there are thousands of transistors. These transistors are connected to each 

other.  

Fourth genera琀椀on of computers are built around microprocessors. A microprocessor 

consists of millions of transistors. These transistors can only be seen through a 

microscope. It controls all func琀椀ons of the device.  
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Lesson 2 – Working with Windows 

This lesson can be taught in two periods. 

Teaching objec琀椀ves 

• To introduce students to an opera琀椀ng system and its role in managing a computer’s 

resources 

• To familiarize students with the Windows environment, including desktop icons, start 

menu, and basic naviga琀椀on 

• To teach students how to manage files and folders, including crea琀椀ng, copying, 
moving, renaming, and dele琀椀ng them 

 

Learning outcomes 

By the end of this lesson, students will have a be琀琀er understanding of system management. 
Students will also be able to make changes to the se琀�ngs and add devices. They will also be 

able to navigate the control panel and explore its various op琀椀ons. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Start the chapter by introducing various opera琀椀ng systems to the students. Find out if they 
are familiar with Bill Gates, the man who founded Microso昀琀. Inform them of Windows 7 and 
the existence of earlier opera琀椀ng systems, such as Windows 95, 98, XP and so forth. 

Main Lesson: 30 minutes 

Take your students to the computer lab for this lesson. Introduce them to the various 

components of the desktop display. Show them how to make new folders and rename them, 
as well as how to change Wallpapers. They may be familiar with copying and moving files 
and folders. 

Describe icons and their func琀椀ons on a computer. They can be compared to quick links or 
shortcuts that make it easier for us to open files and programmes. You can let the students 
explore the desktop and iden琀椀fy common icons such as ‘This PC’, ‘Recycle Bin’ and any 

others. Discuss what each icon represents and what may happen if they double click on it. 

Teach the importance of keeping the desktop organised and to not delete or move icons 

without first understanding their purpose, as this can affect the computers performance. 

Explain that ‘My Computer’ or ‘This PC’ is like a house where all of the important things on 

the computer files live. Describe how files from the Internet are delivered in the download 
folders. 
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Let the students read pages 8 to 10 with your assistance. You can tell your students that the 

computer is some琀椀mes called This PC or My Computer in various windows version. 

You can compare the ‘My Computer’ icon as the front door to your house. When you click on 

it, it's like opening the door to see all the rooms inside. Each room is a drive or place where 

your computer stores various files. You have a room for your toys and games (which are your 
files and documents). Just like your house has different rooms for different things, ‘My 

Computer’ shows you where everything lives on your computer. 

Explain to your students that on a computer, the Recycle Bin icon is like a trash can in your 
classroom. When you don't need a piece of paper anymore, you throw it in a trash can. 
Similarly, when you don't need a file or a folder on your computer, you can put it in the 
Recycle Bin. In the similar way, you can take something out from the trash can if you change 
your mind in real life. Similarly, you can also go to the Recycle Bin and take the file back. 

Explain the ‘Control Panel’ icon to your students using the example of a toolbox for your 

computer. A toolbox is needed to fix things in your house. The control panel works in the 

same way. You can change the se琀�ngs to make your computer work just how you like it. You 

can do things like make your screen brighter, change the volume and even add new 
programs. It's like having a set of tools to help look a昀琀er your computer and make sure it's 
just right for you. 

To see if they are understanding the lesson, you can ask them ques琀椀ons given below: 

• What is a control panel? 

• Can anyone tell me what the control panel does? 

• Why is it important? 

• Can you show me how to open a programme from the desktop? 

• If you wanted to save a picture from the Internet where would you put it on the 
computer? 

• How can you change the background picture on your desktop? 

• Who can you ask for help if you are having trouble with your computer? 

Explain ‘Windows Explorer’ like a big library in your computer where you can find all your 
files and folders. Imagine yourself having a bookshelf at home with all your favourite books, 
games and pictures. Windows Explorer is just like that but it's on your computer. You can 
open it to see everything you have saved, like your homework, drawings or photos. It's a 
place where you can organise your things into different sec琀椀ons so you can find them easily 
when you need them. Tell them that just like a librarian helps you find books in a library, 
Windows Explorer helps you find your files on the computer. 

Discuss with your students about finding things on your computer. It's like a treasure hunt. 
Click on the folder icon on your taskbar to open it. You'll see lots of folders where your 

treasures could be hidden. You can open these folders to find your files. 

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. The exercises can be done as homework or classwork. 
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Sample Tasks 

• Create bingo cards with different desktop icons instead of numbers. Call out the 
func琀椀ons, and ask the students to mark the corresponding icon. 

• Assign each student an icon and have them act out the icon’s func琀椀on while the others 
guess which icon they are. 

• Use cards with different file types and have students decide which ones should be 
“deleted” and placed in a mock Recycle Bin. 

• On a computer, let students prac琀椀ce moving unwanted files to the Recycle Bin and then 
emptying it. 

• Have students create their own Recycle Bin from cardboard boxes and decorate them 

with eco-friendly materials. 

• For a classroom ac琀椀vity, you could create a simple matching game with cards that show 

different se琀�ngs you can find in the Control Panel. Students can match the se琀�ng to 
what it does, like matching a picture of a speaker to a card that says “change the 

volume.” This can help them understand what kinds of changes they can make in the 

Control Panel. 

• Have students prac琀椀ce crea琀椀ng, renaming, and organizing folders within Windows 
Explorer to understand the structure. 

Exercise Answers 

A. Answer the following ques琀椀ons. 

1. Windows Explorer is the File and folder management program of Windows. The basic 

purpose of Windows Explorer is to allow the user to see, copy, delete and manage 
their files on the hard drive of the computer. 
 

2. It contains the folders which are automa琀椀cally made by Windows. This includes 
Downloads, Favourites, My Documents, My Music, My Pictures, My Videos, Saved 
Games and Searches. 

 

3. On the le昀琀 is a list of loca琀椀ons in the Windows OS. The right side is blank. 
 

B. Complete the following statements. 

1. Downloads folder  

2. background, icons and a task bar 

3. recycle bin 

4. Windows Explorer 

5. search box 
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C. Fill in the blanks with correct answers. 

1. Personalize 

2. Computer 

3. My pictures 

4. Windows explorer 

5. USBs 
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Lesson 3 – Mastering Word 

Teaching objec琀椀ves 

• To learn how to select a font 

• To learn how to change the colour of the font 

• To learn how to insert a headline in a document 

• To learn to print and save a file 

Learning outcomes 

Students will learn how to navigate Microso昀琀 Word and use its basic features. They will also 

prac琀椀se crea琀椀ve wri琀椀ng and storytelling. Students will understand the importance of saving 

work regularly. They will gain experience in presen琀椀ng their work and providing feedback. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Let the students read from the lesson. You can demonstrate how to open a document on the 

computer. Take students to the computer lab where they will learn in groups through peer 

learning. 

Main Lesson: 30 minutes 

Explain the concept of a headline to the children. It is the 琀椀tle of an ar琀椀cle and is usually 

bold and larger than the rest of the text. You can show them how to select the Insert tab on 

the ribbon at the top of the page. Click on ‘Header’ in the Insert tab. This will drop down a 

menu of different header styles. Choose a style and click on it. The header sec琀椀on will then 
appear at the top of the document. Type the headline into the header sec琀椀on. Format the 
headline by selec琀椀ng the text and choosing a font size and style that makes it stand out. 

You can explain what a font is while reading about it in the lesson. It is the design of the text 

and different fonts can be used for different purposes. Show them where it is located on the 

computer screen. Click on the font dropdown menu and show a list of all the available fonts. 

Scroll through the list with the children and let them see the different font styles. Have the 
children click on the font they want to apply to their text. Let them type something and 

change the font mul琀椀ple 琀椀mes to see how it affects the appearance of their text. Next, you 

can show them how to change the colour of the font. You can ask the students to type some 

text or select the text they want to change the colour of. Go to the Home tab on the ribbon. 

Look for the font sec琀椀on. This is where they will find different op琀椀ons for forma琀�ng text. 
Click on the Font Colour bu琀琀on. It looks like a le琀琀er a with a colour bar pale琀琀e underneath 
it. They can click on the colour they want to apply on a selected text. 

Discuss the importance of saving the work. Here's how you can explain to the children:  
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Imagine you are building a tower with blocks. If you don't glue the blocks together, what 
happens if someone bumps into it? It might fall down and you would have to start over. The 
same thing can happen with your work on the computer. If you don't save your work in 

Microso昀琀 Word, several things could happen. There could be a power outage. If the 
electricity goes off suddenly, your computer will turn off and everything not saved will be 
lost. Some琀椀mes computers can stop working properly. If Microso昀琀 Word or the computer 

crashes and your work is not saved, it will be lost. So, always remember to save your work 
regularly. A visual demonstra琀椀on can be very effec琀椀ve in helping them understand the 
importance of saving their work. 

You can also demonstrate the saving and prin琀椀ng of a file to the students. Make sure to 
demonstrate these steps live on a computer and let the students prac琀椀se under supervision 
to ensure they understand the process. Encourage them to ask ques琀椀ons and explore the 

different op琀椀ons available in the Save as and Print dialogue boxes.  

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. The exercises can be done as classwork or homework. 

Sample Task 

Ask the students to create a story book in Microso昀琀 Word. Have each student think of a 
short story idea using all the features they have learned in the lesson. Ask students to give 

construc琀椀ve feedback on each other's work. 

Exercise Answers 

A. Tick the ( ) the correct answers. 

1. Word processor 

2. File tab 

3. Recent 

4. Exit 

5. Save As 

 

B. Answer the following ques琀椀ons. 

1. Times New Roman, Arial, Calibri 
 

2. Click File tab and select ‘Print’, a print menu will appear. Select your connected 

printer and click ‘Print’. Your document will be printed. 

 

3. Click the File tab, there is an op琀椀on of ‘Save As’ click on it. Type a name of document 

in file name op琀椀on, click on the ‘Save’ bu琀琀on. 
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Lesson 4 – Understanding PowerPoint 

Teaching objec琀椀ves 

• To understand the purpose of using MS PowerPoint 

• To learn its main features 

Learning outcomes 

By the end of the lesson, the students will be able to navigate the MS PowerPoint interface, 
use toolbars and access various features. They will also be able to share ideas more clearly 

and effec琀椀vely through the use of text, images and mul琀椀media. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Start with a brief overview of what MS PowerPoint is and its uses in different fields. 
Encourage students to come up with ideas for a magical adventure.  

• Where will they go? 

• Who might they meet? 

• What challenges they might encounter? 

Main Lesson: 30 minutes 

Take your students to a computer lab for the lesson. Introduce them to Microso昀琀 
PowerPoint and its various features. You can show them how to create a new presenta琀椀on, 
select themes, use templates and insert text and images. 

Allow the students to read from the text with your assistance. You can explain to them that 

the Home tab is where we find all the tools we need to create a presenta琀椀on. The Home tab 

is organised into groups. Each group has a set of related tools. Point to the Slide sec琀椀on and 
show the students that you can add new slides and decide what layout they should have. 

Next point to the Font sec琀椀on and you can ask them to try changing the text size and colour. 

Show the students they can organise the text, make lists or aligning text to look neat by 

using the Paragraph sec琀椀on. Show them how to add shapes and lines to their slides by using 

the Drawing sec琀椀on. Give the students enough 琀椀me to follow the instruc琀椀ons for the given 
sec琀椀ons in that lesson. 

Point out the Insert tab on the MS PowerPoint ribbon at the top of the screen. It has 

different groups with bu琀琀ons for adding various elements. Explain the purpose of the Insert 
tab by showing them what they can add to their slides. There could be pictures, shapes and 
even videos. The Images sec琀椀on is where we can add pictures from our computer or the 
Internet. If there is a need to add music or a video, Media is the group to use. 
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Coming to the Design tab, explain that this tab is like an ar琀椀st's pale琀琀e of MS PowerPoint. 

Using the tools, we can make our slides look beau琀椀ful and professional. You can discuss with 
them how to choose themes and colours that match the content of their presenta琀椀on. 

While discussing about Slideshow tab, explain that it is where we can see our slides come to 

life. It is like a ‘play’ bu琀琀on for our presenta琀椀on. You can teach the students how to start the 

presenta琀椀on from the beginning by clicking on ‘From beginning’ or from a specific slide by 
choosing ‘From current slide’. Show them how to move forward and backward through the 

slides using the arrow keys on the keyboard. If available, demonstrate the ‘Presenter View’, 
which lets the presenters see notes an upcoming slides while the audience can only see the 

current slide. Let the students prac琀椀se star琀椀ng and naviga琀椀ng through a slideshow. They can 
take turns presen琀椀ng a slide to the class. 

You can ask them the following ques琀椀ons to see if they are understanding the lesson: 

• What is MS PowerPoint used for? 

• Can you show me how to create a new slide? 

• How do you add pictures or video to your slides? 

• How would you change the design or theme of your presenta琀椀on? 

• Can you explain how to save your MS PowerPoint presenta琀椀on? 

At the end of the lesson, remind your students to save their work before shu琀�ng down the 
computer. 

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. The exercises given in the lesson can be done as 

classwork or homework. 

Sample Task 

As a prac琀椀cal exercise, ask the students to create a short presenta琀椀on about their favourite 
animal, using the tools in the Home tab to format their slides. 

Create a mini-project where students can prac琀椀ce inser琀椀ng different elements into a slide. 

For example, they could make a slide about their favourite hobby and include a picture, a 
shape, and a text box describing the hobby. 

Exercise Answers 

A. Answer the following. 

1. .ppt 

2. Clipboard, Slide sec琀椀on, Font sec琀椀on, Drawing sec琀椀on, and Paragraph sec琀椀on 

3. This tab is used to add mul琀椀media elements such as (pictures, videos and sounds) 
into a presenta琀椀on.  

4. Go to the Home tab and click the New Slide op琀椀on. A new blank slide will appear on 
screen. 
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5. You should always view your slideshow before presen琀椀ng them to others. This way 
you can make sure that the presenta琀椀on is free from all sorts of errors. 

 

B. True and False 

1. FALSE 

2. FALSE 

3. TRUE 

4. FALSE 

5. TRUE 
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Lesson 5 – Working with Spreadsheets 

Teaching objec琀椀ves 

• To understand MS Excel used for organising, calcula琀椀ng and analysing data 

• To discuss its usage and implementa琀椀on in real-life situa琀椀ons 

Learning outcomes 

By the end of the lesson, the students will be able to understand the concept of 
spreadsheets as a grid of cells used for organising and analysing data. They will recognise 

that spreadsheets are versa琀椀le tools for various tasks. They will learn how to input data 
(numbers, text) into cells. They will understand the importance of forma琀�ng data (font size, 
bold, etc.) to make it visually clear. They will use spreadsheets to plan events, answer 
ques琀椀ons and solve real-life problems. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Provide a printout of a blank spreadsheet with grids, highlighted cell, and cell address and 
le琀琀ers. Encourage students to suggest possible applica琀椀ons for this program. A昀琀er students 
have provided answers, label and discuss the func琀椀ons of spreadsheet terms such as row, 
column, cell, cell address, ac琀椀ve cell and range. 

Main Lesson: 30 minutes 

Let the students read the lesson with your assistance. Explain the concept of rows, columns, 
cells, worksheets and grid on a spreadsheet. Introduce programs for it and explain how data 
is organised on a spreadsheet. 

Describe a workbook as a collec琀椀on of pages (like a notebook). In MS Excel, a workbook is 
like a digital notebook that holds mul琀椀ple sheets (worksheets). Each sheet is a separate page 

within the workbook. 

Next, explain that a worksheet is a single page within an MS Excel workbook. It is where you 

organise and analyse data. Think of it as a table with rows and columns. You can enter 

numbers, text and formulas into cells on a worksheet.  

Show them a physical notebook with mul琀椀ple pages. Explain that each page is like a 
worksheet in MS Excel and the en琀椀re notebook is the workbook. Relate this to MS Excel by 

opening a new workbook and crea琀椀ng mul琀椀ple worksheets.  

You can take the children to the computer lab to prac琀椀se working on Microso昀琀 Excel. Ask 
your students to open MS Excel and create a new workbook. Add a few worksheets (tabs) by 

right-clicking on the sheet tabs at the bo琀琀om. Rename the worksheets (for example sheet 1, 
sheet 2, etc.). 
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Teach them how to enter data (numbers, text) into cells. Show them how to navigate 
between worksheets using the sheet tab. 

Discuss with your students about MS Excel being a part of our daily lives. MS Excel helps us 

manage our money. We can create a budget spreadsheet to track our pocket money, 
allowances or savings. Students can learn to input their weekly expenses (snacks, toys, etc.) 

and calculate their remaining balance. Teachers use MS Excel to keep track of students’ 

results and a琀琀endance. Explain how data is organised and how formulas can calculate 

averages or totals. 

Discuss the various types of data. There are three types of data values. Text data type 

(labels). Text data includes words, sentence and any other alphanumeric characters (le琀琀ers, 
numbers, symbols). Relate this to the content they write in their school notebooks or on a 

piece of paper. In an MS Excel cell, one can type text directly. Remind the students that text 

data helps us describe things, write messages, and organise informa琀椀on.  

The next type of data value is number. It is used for numeric values in MS Excel. It includes 

both whole numbers (5, 10, 100, etc.) and decimal numbers (3.14 or 0.5, etc.). Show the 

students that they can directly type numbers into cells. They can use them for calcula琀椀ons 
such as adding, subtrac琀椀ng or finding averages.  

The third type of data value is formulas. You can explain that formulas are like magic 

instruc琀椀ons for MS Excel. They allow us to perform calcula琀椀ons and make our spreadsheets 
smarter. You can teach them simple formulas like SUM (add numbers) and AVERAGE (find 
the mean). Show how to write a formula using the equals sign (=). 

Discuss about entering data in spreadsheets in a crea琀椀ve way. Imagine the spreadsheet as a 

ba琀琀leship grid. Each cell is like a spot on the ocean where ships hide. Teach students to 
enter ship coordinates (like A1, B3) into cells They can mark hits (X) and misses (O) using 
different colours. What would be the goal? Sink the opponent’s ship by guessing their 

coordinates! You can let your students prac琀椀se working on the spreadsheet through this 
example. Give them ample 琀椀me to do their work. 

Discuss about how the cells work in MS Excel. Imagine an Excel spreadsheet as a big grid 

made up of 琀椀ny squares. Each 琀椀ny square is called a cell. Cells are where you can type text, 
numbers or formulas. Every cell has a unique address. The address is a combina琀椀on of the 
column le琀琀er and the row number. For example, cell A1 is the first column (A) and the first 
row (1). Cell B3 is the second column (B) and the third row (3). To go to a specific cell, click 
on it. You can also type the cell address directly in the formula bar at the top. 

To see if they are understanding the lesson, you can ask them the following ques琀椀ons. 

• What is a spreadsheet?  
• What are cells? 

• What is a cell address? 

• How do you enter data into a cell? 

• What are columns and rows? 
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• What is a formula? 

Ask students to create a simple addi琀椀on formula (for example, =A1+B1). 

Lastly, you can discuss about how to use AUTOSUM in MS Excel. Tell them that it is a handy 

feature that automa琀椀cally generates some formulas for a selected range of sets. It is perfect 

for quickly calcula琀椀ng totals and subtotals. You can teach them by giving a small 
demonstra琀椀on. Suppose you have a column of numbers (for example monthly sales). Select 

the cell immediately below the last value in the column (for e.g. Cell B7). Go to the home 

tab. In the edi琀椀ng group, click the AUTOSUM bu琀琀on. MS Excel will automa琀椀cally generate 
the sum formula for the selected range (for e.g. B2:B6). Press enter to complete the 

calcula琀椀ons.  

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. You can do the given exercises as a classwork or 

homework. 

Sample Task 

Imagine you're running a sports league (hockey, cricket, etc.). Enter the names of the teams, 
along with their wins, losses and points. Use formulas to calculate rankings and visualise 

standings. 

Exercise Answers 

A. Answer the given ques琀椀ons. 
 

1. Microso昀琀 Excel is a spreadsheet program. It is like a digital table where you can 
organize, store, and calculate data. The informa琀椀on is arranged in rows and columns. 

It is a powerful tool used for tasks such as budge琀椀ng, crea琀椀ng charts, and analysing 
data. 

2. MS Excel finds its use in various aspects of our life. It can be used in educa琀椀onal, 
financial and mathema琀椀cal or sta琀椀s琀椀cal calcula琀椀ons. It also helps in analysing data 

with the help of various charts. 

3. To find a cell’s address, combine the row number and column le琀琀er. 
4. By default, there are three worksheets in MS Excel 2013. 

 

B. Fill in the blanks. 

 

1. Organise 

2. .xls 

3. AUTOSUM 

4. Cell 

 

C. Ac琀椀vity 

Students to complete the ac琀椀vi琀椀es. 
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Lesson 6 – Computer Viruses 

Teaching objec琀椀ves 

• To learn what computer viruses are, how they spread, and their impact on devices 

• To explore various types of malware, including viruses, worms, Trojans, spyware and 
adware 

• To discover ways to protect against malware, such as using an琀椀virus so昀琀ware, 
avoiding suspicious downloads and being cau琀椀ous online 

Learning outcomes 

By the end of this lesson students should be able to explain what can happen if a computer 

is infected with a computer virus. They should be able to define the three types of computer 
viruses: viruses, worms and Trojans. They should also describe how to protect your 
computer from computer viruses. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Explain that a computer virus is like a 琀椀ny, invisible bug that can sneak into your computer. 
Explain that just like you can catch a cold when someone else is sick, a computer virus 
spreads from one computer to another. These bugs can hide inside other programmes or 

files, just like how a 琀椀ny spider might hide in a cosy corner of your room. You can take the 
children to the computer lab and show them on a computer that when they run a 

programme or open a file, the virus wakes up and starts copying itself. Viruses can even do 

harmful things, like making your computer slow down or dele琀椀ng important files. You can 
show them different types of an琀椀virus so昀琀ware that are installed in the computers to make 
them safe from viruses. 

Main Lesson: 30 minutes 

Encourage kids to write short stories or draw comics about computer viruses and how 

an琀椀virus so昀琀ware saves the day.  

Explain to the students about how the computer viruses come into your computer. They can 

come from different places for example emails, downloads, removable hardware and 

websites. Explain to them that some琀椀mes it can arrive in email a琀琀achments. So if you get an 
email from someone you don't know, be careful! They can also hide in programmes or files 
we download from the Internet. It is like finding a hidden treasure chest, but inside, there is 
a sneaky virus wai琀椀ng to jump out! You can also show them the different devices through 

which viruses can be transferred to your computer. Ask them to imagine a USB drive or a 

memory card. If it's infected, it can spread the virus to other computers when plugged in. 
There are some websites that can secretly pass on viruses. It is like a secret handshake 

between the website and your computer! Explain to your children that just like washing our 
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hands keeps us healthy, we use special tools called an琀椀virus so昀琀ware to detect and remove 
these bugs from our computers. We need to update the so昀琀ware o昀琀en to stay safe! Test 
your students by asking these ques琀椀ons: 

• What would you do if you received an email a琀琀achment from an unknown sender? 

• How can you protect your computer from viruses? 

You can explain to the students about the problems that may rise when the computer is 

infected with viruses. Some problems are men琀椀oned below: 

• Sluggish performance 

• Unexpected shutdowns and crashes 

• Missing files 

• Frequent error messages 

• Pop-up windows everywhere 

• Overworked hard drive 

• Data the昀琀 and destruc琀椀on 

Encourage students to think cri琀椀cally about safe prac琀椀ses.  

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. The exercises given in the book can be done as 

classwork and homework. 

Sample Tasks 

• Create a list of common online threats (viruses, phishing emails, etc.). Have kids search 
for examples online and discuss how to avoid them. 

• Encourage kids to write short stories or draw comics about computer viruses and how 

an琀椀virus so昀琀ware saves the day. 
• Show kids how to use an琀椀virus so昀琀ware by se琀�ng a posi琀椀ve example. Demonstrate how 

to install and update an琀椀virus programs, run scans to check for viruses, follow safe 

online prac琀椀ces (e.g., avoiding suspicious downloads). Explain that just like washing 
hands keeps us healthy, using an琀椀virus tools keeps our computers safe. 

Exercise Answers 

A. Mark (  ) for true and (  ) for false statements. 

 

1. True  

2. false 

3. True 

4. True 

5. False 
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B. Describe the following terms. 

 

1. Viruses: They copy themselves and spread their copies to other computers. Viruses 

need to a琀琀ach themselves to a program or file on computer. 
2. Worms: These are different from viruses in that, they do not need a program to 

a琀琀ach themselves to. They can exist and operate independently. 
3. Trojans: They work by decep琀椀on. Outwardly they seem to be useful but inwardly 

they could be damaging to your computer. They are mostly sent by criminals who can 

get benefit from the informa琀椀on taken from your computer. 
 

C. Match the following. 

Data Loss - The most destruc琀椀ve ac琀椀vity of virus  
Loss of control - Actual user does not control the system. 

Hardware damage - Computer equipment is damaged. 

 

D. Write some signs of viral infec琀椀on in a computer. 

 

1. Infected computer usually behaves erra琀椀cally. 
2. Files corrupt frequently. 
3. Several folders do not open and the computer o昀琀en freezes. 
4. You get lots of error messages. 

5. Your hard disk light blinks even when the computer is idle. 
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Lesson 7 – The Living Net: Websites 

Teaching objec琀椀ves 

• To learn what a website is and how it is constantly growing and changing 

• To understand how naviga琀椀ng from one website to another is like moving through a 
network of paths 

• To iden琀椀fy different types of websites and their purposes, such as educa琀椀onal, 
entertainment, news and ecommerce sites 

Learning outcomes 

By the end of the lesson, students should have a founda琀椀onal understanding of websites, 
their significance and how to navigate the Internet responsibly and safely. This knowledge 

will prepare them for more advanced topics in technology and digital literacy. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Explain what Internet is. Tell your students that it is a vast network of connected computers 

that allows people to share informa琀椀on, communicate and access resources. Discuss how 
the Internet impacts our daily lives, from communica琀椀on to research and entertainment. 

Main Lesson: 30 minutes 

Let the students read lesson with your assistance. You can write some of the ques琀椀ons on 
the board and let the students brainstorm. Some of the ques琀椀ons are as follows: 

• Can you explain what Internet is? 

• What are some of the things you like to do on the Internet? Can you name some rules 
you should follow when using the Internet? 

• Why is it important to keep your personal informa琀椀on private on the Internet? 

• How can your ac琀椀ons on the Internet affect you on others? 

You can explain to your students about the Internet in a crea琀椀ve way. Imagine Internet is like 

a big city with lots of different buildings. Each building is a website and each one has a 
different purpose.  

Explain about different types of websites by star琀椀ng with Search Engines. Imagine you are in 
a huge library with billions of books but there is no librarian to help you find what you need. 
That is how a search engine acts like. It is a special programme on the Internet that helps 

you find the web pages you are looking for, just like a librarian helps you find books in a 
library. When you have a ques琀椀on, or you are looking for something specific, you type words 

into the search engine. These are called keywords. The search engine then quickly looks 

through millions of web pages and finds the ones that have the informa琀椀on you need.  

Ask your students ques琀椀ons about search engines: 
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• What are the most popular search engines? 

• How do search engines work? 

• What are some alterna琀椀ve search engines to Google? 

Talk about news websites. Explain that they are like the place where you can get the latest 

from. They tell you what is happening in the world right now.  

Discuss social media websites, blogs, ecommerce websites, community websites, fun and 
games. You can describe about these websites in a crea琀椀ve manner to your students.  

Social media websites are like places where friends meet to chat and share stories and 

pictures. Blogs are like cosy spots where people write about their thoughts and share their 

hobbies. Online stores or ecommerce websites are like big shopping centres where you can 

look at toys, clothes and all sorts of things to buy. There are some websites that are non-

profit. The share their missions, raise awareness and encourage dona琀椀ons or volunteer 
par琀椀cipa琀椀on. Others are online forums and community websites. They allow users to discuss 

topics, ask ques琀椀ons and connect with others who share similar interest. Just like there are 
websites for news and television, some are of similar types for children also. These websites 
are educa琀椀onal, entertainment and interac琀椀ve. These are shown in a child friendly manner, 
helping kids to stay informed. 

Discuss about what other things are done on Internet. There are fun websites that offer 
games for grown-ups and children. Ensure that the children know all the important things to 

look for when they are on gaming website.  

Tell the students that some琀椀mes the Internet becomes a bit unsafe. They should have a 

grown up to check out the website content before using it. Their parents should make sure 

they know who the children are interac琀椀ng with online. Many games and social pla琀昀orms 
websites have chat func琀椀ons that can expose children to conversa琀椀on with strangers. These 
websites also offer in-game or in-built purchases. Discuss with the students the importance 

of not making purchases without permission and be aware of se琀�ngs that can prevent 
accidental purchases. 

Lesson wind-up: 5 minutes 

Recap what was taught in the lesson. The exercises given in the lesson can be done as 

classwork and homework. 

Sample Tasks 

• Discuss the importance of being safe and respec琀昀ul online. 
• Have students search for specific informa琀椀on online. 
• Compare news treatment across different websites. 
• Place the world map on a wall or a table. Have students use strings to connect their 

Internet journey cards on the map, showing how data travels from their home to 
different parts of the world. 
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Exercise Answers 

A. Match the following. 

Website-specific loca琀椀on and specific address 

Search engine- sole purpose is to find things on internet for you 

Google-most popular search engine 

Blog-website for opinions and news presented otherwise 

 

B. Answer the following ques琀椀ons. 
1. A search engine is a type of website to find anything you want on the Internet. 
2. Popular websites are news websites, social media websites, blogs, online stores 

3. Social media is used for interac琀椀ng with your friends without going to their places or 
calling them. 

4. Blogs are websites for discussions and informa琀椀on. They could be on a single topic or 
on a broader category. 

 

C. Mark ( ) for true and ( ) for false statements 

1. True 

2. False 

3. False 

4. True 

5. False 

 

D. Rearrange the following. 

Search engine 

Websites 

Internet 

Google 

News 
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Lesson 8 – The Coming Revolu琀椀on: Computer-driven cars 

Teaching objec琀椀ves 

• To be able to iden琀椀fy and describe the key components and func琀椀ons of self-driving 

cars 

• To understand the safety, convenience and environmental benefits of self-driving cars 

• To be able to use crea琀椀ve and create cri琀椀cal thinking to imagine the future of self-
driving cars and their role in everyday life 

Learning outcomes 

By the end of the lesson, the students will be able to explain what computer driven cars are 
and how they differ from tradi琀椀onal cars. They will learn about the technologies that make 
computer driven cars possible for example sensors, naviga琀椀on and ar琀椀ficial intelligence. 

Lesson plan 

Time period: 40 minutes 

Introduc琀椀on: 5 minutes 

Start by briefly explaining what computer-driven technologies are. You can tell them that 

these technologies can be found in many places like our homes, schools and even in our 
toys. 

Main Lesson: 30 minutes 

Divide the students into small groups and ask them to brainstorm examples of computer 

driven technologies they know about or have seen. Give them a few minutes for this ac琀椀vity. 

Have each group share their examples with the class. Encourage them how to explain how 

the technology works and why do you think it's driven by a computer. You can ask ques琀椀ons 
like: 

• What does this technology do? 

• How does it use a computer to work? 

• Can you think of any toys that might use computers to move or talk? 

• Have you ever seen or heard cars that can drive themselves? 

You can also write a list of devices on the board. Ask the students to name them. 

Let the students read the lesson with your assistance. 

Discuss with your students about the benefits of self-driving cars. Their answers could be like 

this: safety, convenience, efficiency, environmental benefits, and accessibility. Ask them to 
explain each benefits in two to three sentences. 

Let the students understand the technology used by these cars. They have sensors. The 

sensors are of different kinds built inside the car. They include cameras, radar, lidar, and 
ultrasonic sensors.  
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Another type of technology is computers which is the brain of a car. It processes all the 

informa琀椀on from the sensors. Give them example of AI which is a special kind of computer 
programme that helps the car experience and make decisions like a human driver would. 

Another type of technology is Maps and GPS that understands the loca琀椀on. The last type of 
technology is decision-making. 

Lesson wind-up: 5 minutes 

You can conclude the lesson by discussing what the future of computer driven cars would 

look like. You can do the exercises given in your lesson as class work and homework. Recall 

that has been taught in the lesson. 

Sample Task 

Ask students to write a short story about a day in their life with a self-driving car. They 

should include how the car helps them get to school, visit friends, or go on an adventure.  
Encourage them to describe the features of the car and how it interacts with the world 

around it. 

Exercise Answers 

A. Fill in the blanks. 

1. Control systems and distance measuring devices 

2. Computers 

3. Fuel 
4. Naviga琀椀on  
5. Global Posi琀椀oning System 

 

B. Answer the following ques琀椀ons. 
1. reduc琀椀on in number of traffic accidents, fuel efficient, improve the living standard  
2. video, infra-red, laser 

3. (use internet for research) 

 

C. Following are the func琀椀ons of computer driven cars. Match them with the descrip琀椀on 
given below. 

Sensors video, infra-red, laser, radar 

Actua琀椀on  it takes input from drivers and delivers desired effects  

Naviga琀椀on the ability to plan a route from vehicle’s current posi琀椀on to the 
des琀椀na琀椀on 

Mo琀椀on planning it recognised moving obstacles 
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